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In diesem Dokument werden die in Autodesk Mudbox 2013 Service Pack 1 enthaltenen bekannten 

Einschränkungen, Probleme und Problembehebungen beschrieben. Es wird dringend empfohlen, dieses 

Dokument zu lesen, bevor Sie dieses Release installieren.  
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 Behobene Probleme 

Die folgende Liste enthält Bugnummern und die entsprechenden Beschreibungen für Probleme, die in 
diesem Release behoben wurden. 

 

Bugnummer Beschreibung 

MDBX-1628 Need a curve property for controlling virtual "pressure" along the curve for 
Stroke on Curve. 

MDBX-1657 Pressing the Shift key in the Create Curve tool should switch to the Smooth 
Curve tool. 

MDBX-1569 Curve end points are not fixed and the Smooth Curve tool will cause them to 
change. 

MDBX-1536 Grab Curve and Smooth Curve tools do not work on curves without splines. 

MDBX-1488 Cannot create a View Curve after pressing Ctrl+N (to create a new scene). 

MDBX-1442 Grab Curve and Smooth Curve marking menus are incorrect. 

MDBX-1382 Snapping to 3D curve doesn't work on the stencil canvas and may cause crash. 
This functionality has been removed. 

MDBX-1202 View curves break the "Frame Selection" function. 

MDBX-1339 "Snap to Curve" doesn't snap reliably. 

MDBX-1659 Sculpting on tiling plane after deleting some of the faces may cause Mudbox to 
crash. The ability to delete tiling plane faces has been removed. 

MDBX-940 Mudbox environment variable MUDBOX2009_SUBDIVIDE_SMOOTH_UV does 
not accurately match RenderMan UV Smoothing option -- cc smooth borders 
and internal UV's. 

MDBX-8 Subdivide with Smooth UV's is incorrect and should match RenderMan -- linear 
(unchanged) border with cc smoothed internal UV's. 

MDBX-1482 When importing an FBX file that has both blend shapes and creasing from Maya 
2013, the blends shapes fail to load into Mudbox 2013. 

MDBX-1751 PTEX export causes seams in some cases. 

MDBX-1406 Cannot mirror individual sculpt layer if other layers are visible. 

MDBX-1215 Layer > Mirror command produces incorrect result. 

MDBX-1387 Mac OS X: error beeps while clicking on Spacebar marking menu. 
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Bugnummer Beschreibung 

MDBX-1720 Help preference set to use the Installed Local Help instead of Autodesk Web 
Site does not launch 2013 Help. 

 

Einschränkungen und Anmerkungen zu Features 

In diesem Abschnitt werden bekannte Einschränkungen und schnelle Zwischenlösungen für Mudbox 

2013 Service Pack 1 aufgeführt.  

Bitte melden Sie alle weiteren Probleme mithilfe des Bug Reporting-Formulars unter  

www.autodesk.com/mudbox-bugreport oder über den Menübefehl Hilfe > Ein Problem melden... in 

Mudbox. 

Bugnummer Beschreibung 

MDBX-1663 

Mac OS X: File > Send To is not working correctly. Maya or Mudbox will open 
when you select "Send to.." but nothing will be sent. 
Workaround: 
1. Copy the libsynHub.dylib from the Mudbox 2013 SP1 directory:  
/Applications/Autodesk/Mudbox2013/Mudbox.app/Contents/MacOS  
2. Replace the file of the same name in the Maya 2013 directory  
/Applications/Autodesk/maya2013/Maya.app/Contents/MacOS 

388437 

The Gigatexel Engine stops working intermittently after assigning a new 
material or Ptex setup.  
Workaround: Toggle the visibility of the offending paint layer on and off, create 
a new paint layer (can be empty or hidden), or save the file and reopen it to 
restart the Gigatexel Engine.  
You need to start the Gigatexel Engine with this workaround before painting, 
otherwise textures on some tiles will go missing. 

MDBX-1616 
An environment variable MUDBOX_EXPOSE_8K exposes "8192" in the Create 
New Paint Layer "Size" option. (It will not be exposed if less than 512 MB GPU 
available. 1.5 GB or more recommended). 

MDBX-371 

When the amount of texture data exceeds the available GPU on your machine, 
the effects brushes draw red temporarily if "Solo as Diffuse" is ON for a paint 
layer.  
Workaround: Once the stroke is done, the brush correctly applies the effect 
and the result is correct. You can turn off the Gigatexel Engine in the Render  
preferences (which effectively disables the paint buffer) and the effects 
brushes will work correctly. 

388529 

Flip a mesh with crease information and an empty paint layers may cause faces 
to become transparent. 
Workaround: Delete the empty paint layer, or subdivide the mesh, or  
change subdivision levels. 

355918 
Installation: Error that says the product key may be invalid and to re-enter it. 
Workaround: Click OK on this dialog, click Next button again, and if product key 
is valid the installation continues. 

357041 
Mudbox on Linux does not get pressure events from Wacom tablets with 
Fedora 12/Redhat 6, QT 4.5. You can find more details in the bug report here:  
https://bugzilla.redhat.com/show_bug.cgi?id=569132 

https://bugzilla.redhat.com/show_bug.cgi?id=569132
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Bugnummer Beschreibung 

There is a patch for Qt here:  
http://koji.fedoraproject.org/koji/buildinfo?buildID=160252 

358312 
Files that include 16 bit TIF maps will show errors with "Send to Maya..." 
operation. 

360224 
Mudbox crashes if the extraction map output file name contains %S in string 
(for example: AO_(%S).bmp). 

362133 
Creating a joint with Topology Weights doesn't work properly with non-4-sided 
meshes. Workaround: Use alternative Weights method. 

362857 

If the level of the source model is not the current level when extracting a map, 
the detail of lower sculpt layers will be missing.  Workaround: Ensure you 
display the required subdivision level before extracting the map, or select the 
current level in the Extract Texture Maps window to get the correct result. 

363366 
Transfer paint layer works incorrectly if target and source have overlapping 
UVs. 

MDBX-260 

The Transfer Details function works best on objects that are the same size, or 
larger than the default Mudbox meshes. If the transfer produces artifacts on 
the target mesh, try scaling up the source and target meshes to the same size 
as the default head mesh. 

374126 
When using a non US-English standard keyboard, some of the hotkeys may not 
work. Workaround: Set your IME to "English - United States" while using 
Mudbox. For more information see your operating system documentation. 

MDBX-292 
Send to 3ds Max: Changing units between Max and Mudbox causes 
unpredictable results. 

381496 
When painting or sculpting with symmetry ON, sometimes the result will not 
appear on the opposite side. Verify that you have "Falloff based on Facing 
Angle" turned off. 

MDBX-1614 

On Linux, if Mudbox crashes when starting up with an error message such as 
"mudbox: symbol lookup error: /usr/lib64/libssl.so.0.9.8: undefined symbol: 
X509_VERIFY_PARAM_new", try the following workaround:  
1. Install OpenSSL >= 1.0.0 if you haven’t already. 
2. Point the old symbol link to the 1.0.0 version, like "ln -s -f 
/usr/lib64/libssl.so.1.0.0b /usr/lib64/libssl.so.0.9.8"  

MDBX-1203 
If a portion of a curve on a mesh is obscured (for instance, if a portion of the 
curve is on the back side of an object) and you use Stroke on Curve" with mirror 
ON, results may be incorrect. 

MDBX-456 
On Linux Fedora 14+ the SELinux is false by default. This may prevent Mudbox 
from launching properly and produce plugin errors. A possible workaround is to 
set the SELinux enforcing mode to "Permissive" or "Disable". 

MDBX-341 
When saving a .mud file to replace the original .mud file with the same name 
the file will also keep the original file size. To save the file with the actual file 
size use "Save Scene As..." and save the file with a new name. 

MDBX-1556 
On Mac OS X the installer may hang at end of a successful installation. It is 
recommended to force quit the installer. Mudbox will then run normally. 

 

 Zum Ausführen von Mudbox 2013 müssen Sie einen Prozessor verwenden, der SSE3-kompatibel ist. 

Mudbox verwendet SSE3-spezifischen Code, der keine Ausführung von Mudbox auf Hardware 

erlaubt, die SSE2 oder ältere Versionen unterstützt.  

http://koji.fedoraproject.org/koji/buildinfo?buildID=160252
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 Das Formen mit aktivierter Option Stempelabstand führt dazu, dass der Pinselstempel an die 

Cursorposition versetzt wird, wenn Sie ein Wacom Cintiq- oder Wacom-Tablett verwenden, falls für 

den Stylus der Einstellungsmodus Maus gesetzt ist. Um diesen Fehler zu beheben, fügen Sie die 

Umgebungsvariable "MUDBOX_USE_LOWRES_TABLET_DATA" hinzu.  

 ATI-Grafikkarten: Wenn Sie Beschädigungen in den gezeichneten Texturen feststellen, z. B. schwarze 

Bereiche und Darstellungsfehler, kann das Hinzufügen der Umgebungsvariablen 

"MUDBOX_PAINT_CONTEXT_FLUSH" das Problem möglicherweise beheben. 

 Einige Benutzer erhalten möglicherweise falsche GPU-RAM-Berichte, die zu vielen Popup-

Warnungen führen. Diese erscheinen jedes Mal, wenn sie Layer erstellen bzw. zusammenführen 

oder die Sichtbarkeit von Layern ändern. In der Umgebungsvariablen "MUDBOX_FORCE_GPU_RAM" 

(nur Windows) können Sie die Menge des GPU-Speichers (in Megabyte) überschreiben, der Mudbox 

zusteht. Wenn Sie eine NVIDIA Quadro 5600-Karte haben und im Bericht 1 MB RAM (GPU) gemeldet 

wird, setzen Sie die Variable für diese Karte auf 1536 (1,5 * 1024). Nicht numerische Werte werden 

ignoriert, und die Werte werden im Bereich 256 bis 4096 arretiert. 

Anmerkung: Weitere Informationen über diese Umgebungsvariablen finden Sie im Thema 

Umgebungsvariablen in der Mudbox-Hilfe.  

 Sie können die Mudbox-Hilfe von http://www.autodesk.com/mudbox-helpdownload-deu 

herunterladen und lokal installieren. 

 Wenn Sie zuvor eine Beta-Version (einschließlich Release Candidate-Versionen) von Autodesk 

Mudbox 2013 installiert haben, müssen Sie zunächst alle zur Vorversion gehörenden Systemordner 

vor der Installation der kommerziellen Version deinstallieren und löschen.  

(Windows 32-Bit und 64-Bit) Fehler bei der Deinstallation oder Reparatur von Mudbox 2013 mit der 

Meldung „SetupRes.dll is not found“ 

Diese Verwaltungsfehlermeldung tritt auf, wenn Autodesk Mudbox 2013 in einem Suitepaket oder aus 
einem standalone-Image installiert wurde und die ausgewählte Sprache des Produkts keine der vier von 
Mudbox unterstützten Sprachen (Englisch, Französisch, Japanisch, Deutsch) ist.  

 
Fehlerbehebung: Hierfür benötigen Sie Administratorrechte. Nehmen Sie die folgenden 
Änderungen an der Registrierung vor, und versuchen Sie die Reparatur oder Deinstallation 
anschließend erneut: 
 
Für 64-Bit-Versionen von Windows  
Schlüssel:HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\Autod
esk Mudbox 2013 64-bit\   
Name: UninstallPath 
Daten:  <Installationsverzeichnis>\Setup\Setup.exe /P {0C821839-EA2A-48C2-BBD5-
2B3D28159BC0} /M Mudbox /LANG ko-KR   en-US 
 
Für 32-Bit-Versionen von Windows 
Schlüssel: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\Autodesk 
Mudbox 2013 32-bit\   
Name: UninstallPath 

http://www.autodesk.com/mudbox-helpdownload-deu
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Daten:  <Installationsverzeichnis>\Setup\Setup.exe /P {A675D66E-0CBD-4A8F-0068-
82B774DD4C9E} /M Mudbox /LANG ko-KR   en-US 

 
SDK-Beispiele 

Unter Mac OS X werden Release-Konfigurationen möglicherweise nicht korrekt erstellt. Benutzer 
müssen die Active Architecture in Xcode auf x86_64 setzen. Gehen Sie dazu folgendermaßen vor:  
1. Öffnen Sie ein Beispielprojekt mit Xcode.  
2. Wählen die Menüleiste Project > Edit Project Settings.  
3. Wählen Sie die Registerkarte Build.  
4. Stellen Sie im Fenster Setting unter Architectures sicher, dass der Wert für Architectures auf 64-bit 
Intel gesetzt ist.  
5. Schließen Sie das Fenster, und erstellen Sie das Projekt mit der Release-Konfiguration.  

 
PtexImporter-Beispiel erfordert, dass PtexExtractor-Beispiel erstellt und in das Build-Verzeichnis kopiert 
wird, um es verknüpfen zu können.  
 
Um das Drehscheiben-Beispiel zu erstellen, installieren Sie QT, und führen Sie moc für die 
Headerdateien des Beispiels aus. Im Beispiel finden Sie eine Readme-Datei. 

Weitere Ressourcen 

Die vollständigen Anweisungen für die Installation und Lizenzierung finden Sie in der Installationshilfe 

und der Lizenzierungshilfe. Der Zugriff auf diese Handbücher erfolgt über die Verknüpfung Hilfe zur 

Installation des Mudbox-Installationsprogramms oder hier:  

http://www.autodesk.com/mudbox-install-2013-deu 

http://www.autodesk.com/me-licensing-2013-deu 

Informationen zu neuen Funktionen finden Sie im Abschnitt "Neue Funktionen" der Mudbox-Hilfe 

unter:  

http://www.autodesk.com/mudbox-help-2013-deu-whatsnew 

Hier finden Sie Schulungsressourcen für Mudbox:  

http://www.autodesk.com/mudbox-learningpath 

 

Schauen Sie sich Videos an, um zu erfahren, wie Mudbox funktioniert: 

http://www.autodesk.com/mudbox-trainingvideos 

 

Hier finden Sie Ressourcen zum Support und zur Fehlerbehebung: 

http://www.autodesk.com/mudbox-support 

 

Eine aktuelle Liste der zertifizierten Hardware, einschließlich Grafikkarten, zum Ausführen von Mudbox 

2013 finden Sie im Mudbox 2013 Certification Chart: 

http://www.autodesk.com/mudbox-hardware 

 

http://www.autodesk.com/mudbox-install-2013-deu
http://www.autodesk.com/me-licensing-2013-deu
http://www.autodesk.com/mudbox-help-2013-deu-whatsnew
http://www.autodesk.com/mudbox-learningpath
http://www.autodesk.com/mudbox-trainingvideos
http://www.autodesk.com/mudbox-support
http://www.autodesk.com/mudbox-hardware
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Die Mudbox 2013-Mindestsystemanforderungen können hier eingesehen werden: 

www.autodesk.com/mudbox-systemreq-2013-deu 

 

Dokumentation und Beispiele für das Mudbox SDK zu Ihrer installierten Version von Mudbox finden Sie 

im Pfad \Mudbox 2013\SDK oder online unter: 

http://www.autodesk.com/mudbox-sdkdoc-2013-enu 

 

Programm zur Kundeneinbeziehung (CIP) 

Beim ersten Start von Mudbox wird das Dialogfeld Programm zur Kundeneinbeziehung geöffnet. Wenn 

Sie sich dafür entscheiden, an diesem Programm teilzunehmen, wird Mudbox automatisch 

Informationen über Ihre Systemkonfiguration, die am häufigsten verwendeten Features, eventuell 

aufgetretene Probleme sowie andere Informationen an Autodesk senden, die für die künftige 

Entwicklung des Produkts hilfreich sind. Weitere Informationen finden Sie unter 

http://www.autodesk.com/cip. 

 

Kunden-Fehlerberichte 

Zur Verbesserung der Stabilität von Mudbox tragen zu einem großen Anteil die Kunden-Fehlerberichte 

bei, die uns Benutzer unserer Produkte übermitteln. Wir bedanken uns bei Ihnen für Ihre Zeit zur 

Übermittlung dieser Berichte und Fragen und wünschen uns, dass Sie so viele Informationen wie 

möglich zu den Aktionen angeben, die Sie durchführten, als der Fehler aufgetreten ist. Diese Angaben 

erhöhen den Wert des Berichts für uns erheblich und werden vom Autodesk Mudbox Engineering-Team 

sehr geschätzt.  

Weitere Informationen über Kunden-Fehlerberichte finden Sie unter http://www.autodesk.com/cer.  
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